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New Imaging Equipment Setup 
Andy Grant 

 

Introduction 
 

This document describes taking a Windows laptop, installing and setting up various drivers and 

applications to get an imaging rig up and running.  The intent is to help new imagers with the 

sometimes-daunting task of getting so many pieces of software and hardware talking to each other, and 

then gathering data with it.  And to perhaps serve as a place to look back for notes if something in it 

proves useful. 

I recently bought a new laptop to replace the one I used previously for imaging.  The club also recently 

had some tech talks to answer questions about imaging.  Attending those tech talks I could tell a lot of 

new imagers were having some difficulties getting their equipment all set up, their scopes focused, etc.  

That prompted me to write this document.  I took the opportunity (since I now had an unused laptop) to 

reset the OS on my old imaging machine (which removes all software and drivers).  I then set it up to 

image from scratch, documenting my progress (mainly taking a bunch of screenshots). 

This is specific to the equipment and software I use, with some small exceptions.  I chose to use NINA as 

the sequencer here because it is free, and simpler to use than Sequence Generator Pro and Voyager (the 

two that I have or currently use).  NINA is better suited to someone just starting out but was not 

available when I started imaging (or at least I was not aware of it if it was available). 

I also started out using PlateSolve2 for plate solving but have recently switched to ASTAP.  ASTAP is 

easier to set up and has been working well for me so far.  So ASTAP is the plate solver included. 

At any rate, I hope this document will help even if the equipment you have is not exactly what I have.  

Just use the parts that apply to you. 

The hardware used: 

• Mount: SkyWatcher EQ6-R Pro 

• Imaging camera: ZWO ASI1600MM-Pro 

• Imaging scopes: 

o 90mm Stellarvue refractor used for photos demonstrating back-focus 

o Canon 200mm camera lens for image capture 

• Guide camera: ZWO ASI120MM-S 

• Guide scope: ZWO 30mm f/4 mini guide scope 

• Filter wheel: ZWO 8-slot EFW 

• Laptop: Windows 10 OS 

The software used: 

• ASCOM platform 
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• ASCOM mount driver: EQMOD EQASCOM 

• Planetarium: Cartes du Ciel (CdC) 

• Guiding: PHD2 

• Sequencer: NINA 

• ZWO native drivers 

• ZWO ASCOM drivers 

• Platesolving: ASTAP 

• Data Capture: SharpCap 

Keep in mind web page links, links shown on various screenshots, etc. may change between the writing 

of this document and when it is read.  I hope you find this useful.  Let us get started. 
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Control the Mount 
 

First, let us get the computer talking to the mount.  In this section, we will download and install the 

ASCOM platform, EQMOD’s EQASCOM driver and Cartes du Ciel.  Then we will set them up and get them 

working together. 

 

Download the ASCOM Platform 
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This is a Windows-specific framework that provides common APIs that astronomy vendors can build 

their software to.  It makes it easier to get products from various manufacturers communicating with 

each other.  If you are using a Linux or MacOS based machine, ASCOM does not apply to you. 

The ASCOM platform can be downloaded from here: 

https://www.ascom-standards.org 

The download link is on the right side of the home page: 

 

 

  

https://www.ascom-standards.org/
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Install the ASCOM Platform 
 

Run ‘ASCOMPlatform65.exe’.  Click the Next button on the pre-requisites page if you see it: 
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Then click the Install button on the setup page: 

 

 

Once the install completes, click the Finish button: 
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Download the EQMOD Project’s EQASCOM Driver 
 

This is a driver that talks directly to the mount’s motor controller and provides an ASCOM interface for 

other software.  This is primarily for SkyWatcher and Orion mounts.  It also appears to support some 

Avalon and Vixen mounts.  The list of supported mounts is here: 

http://eq-mod.sourceforge.net/reqindex.html 

SkyWatcher (and most other mount manufacturers) provide standard ASCOM drivers.  If you do not 

want to use EQASCOM or do not have a supported mount, look for a standard ASCOM driver for your 

mount and use it instead. 

EQASCOM can be downloaded from this page: 

http://eq-mod.sourceforge.net/eqaindex.html 

Click the downloads link:

 

That will redirect you to another page.  Click the Sourceforge link on that one: 

 

  

http://eq-mod.sourceforge.net/reqindex.html
http://eq-mod.sourceforge.net/eqaindex.html
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On the Sourceforge page, click the EQASCOM folder link: 

 

 

On the next page, notice the big green download button is WRONG.  It has been incorrectly set to 

download ASCOMPAD instead of EQASCOM.  Use the latest version link below the green button instead: 
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Install EQASCOM 
 

Run ‘EQASCOM_V200q_Setup.exe’.  Click the Next button on the Welcome dialog: 
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Select additional options and click the Next button: 

 

 

Click the Install button: 
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When the install is complete, click the Finish button: 

 

 

Read the pdf that opens.  It has a lot of useful information about EQASCOM. 
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Download Cartes du Ciel 
 

CdC can be found here: 

https://www.ap-i.net/skychart/en/download 

Click the Windows 64bit setup link: 

 

 

My mount is an EQ6-R Pro that is about 2 years old.  To control it with a laptop, without connecting the 

hand controller, I need a special cable.  It plugs into a USB port on the laptop, provides a USB-to-serial 

interface, then provides the serial communications to my mount through an RJ45 jack.  I got my cable 

from Shoestring Astronomy: 

http://www.store.shoestringastronomy.com/products_eq.htm 

For my mount, I needed the USB2EQ5 cable.  Your mount may be different than mine.  Orion mounts 

may have a DB9 serial connector for example.  And I believe SkyWatcher mounts newer than mine even 

have the USB-to-serial functionality built-in to the mount.  They will have a USB connector on the mount 

head and should just need a simple USB cable from the laptop to the mount.  Do some research to see if 

you need a special adapter cable, and if so, exactly which one. 

  

https://www.ap-i.net/skychart/en/download
http://www.store.shoestringastronomy.com/products_eq.htm
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Install CdC 
 

Run ‘skychart-4.2.1-4073-windows-x64.exe’.  Click the Next button on the Welcome dialog: 
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Click the Next button on the Information dialog: 

 

 

Change the installation folder if you like and click the Next button: 
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Choose your Start Menu options and click the Next button: 

 

 

Choose additional options and click the Next button: 
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Click the Install button after all the option dialogs are done: 

 

 

Once the install completes, click the Finish button: 
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Find the COM Port for Mount Control 
 

We need to figure out what COM port will be assigned to the mount when connected. 

Before connecting the mount to the computer, press ‘Win+X’ (Press and hold the Windows key, then the 

X key). 

Select ‘Computer Management’ from the list. 

Select ‘Device Manager’ on the left and expand ‘Ports’ on the right if you have an entry for it (I do not 

yet have a Ports section): 
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I run my mount through a USB hub.  So first, I plug in the hub (while the computer management window 

is open). 

I now see a Ports section and a Port (COM4) under it (you may need to expand the Ports section): 
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Finally, plug in the EQDIR cable (to the computer, not the mount).  I now show a new Port (COM3): 

 

 

Note if you have a newer mount that does not require an adapter cable, you may need to plug the USB 

cable into both the computer and the mount, and may need to power the mount as well. 

Make a note of the COM port that appears when you connect the mount.  You will need it later.  Power 

down the mount, unplug the mount (controller) cable. Close the computer management window. 
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Configure CdC 
 

Open CdC.  Press the Windows key and type ‘Cartes du Ciel’. 

You will see an information dialog (only the first time CdC is opened).  Click the Next button: 
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On the Observatory dialog, set up your location.  Give this location a name, then set the latitude, 

longitude, and time zone.  Click the Save button (so save the named location), then the Apply button: 

 

 

 



Page | 23  
 

Under the Setup menu, select Date/Time: 

 

 

 

On the Date/Time dialog that pops up, check Use System Time, and Auto-refresh every 60 seconds 

(change the value if you want). 
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Click the Apply button, then the OK button: 

 

 

 

 

Close CdC.  Click the Yes button to save your settings. 
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Configure EQASCOM 
 

Set your mount to the ‘Home’ position and engage the clutches.  Home position is with the 

counterweight bar down, and the scope pointed to the North Celestial Pole (NCP), parallel to the RA 

axis. 

Connect the USB adapter to your computer and mount.  Power up the mount. 

Click the Windows button to bring up the ‘start menu’.  Find the ‘EQMOD’ section and click it to expand 

it.  Click ‘Setup EQASCOM’.  I believe ‘Setup EQASCOM2’ is for installs that include 2 instances of 

EQASCOM (not covered here). 

On the dialog, set the latitude and longitude to match CdC. 

Click the binoculars button.  That is supposed to find your mount.  It has never worked for me.  If it does 

not work for you, manually choose the COM port below the binoculars button.  Set Baud to 9600.  Note: 

9600 baud is what I need for my mount.  If you have a newer EQ6-R that includes the USB-serial adapter 

in the mount head (or another mount altogether), you may be able to use a higher baud rate.  Set the 

timeout to 1000, and retry to 2. 
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Select the ‘Allow Auto Meridian Flip’ checkbox.  Set the Name of your site and save that if you want. 
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Set the Epoch to J2000. 

Click OK at the bottom of the dialog when you are done setting options.  Remember to use the COM 

port for YOUR mount.  It might not be COM3. 

 

 

This was a quick ‘do this, do that’ approach to setting up EQASCOM, specific to my mount.  The EQMOD 

project has a lot of features.  They have also put several videos on YouTube that may be useful to learn 

about them and for troubleshooting issues that might come up.  Those videos can be found here: 

https://www.youtube.com/playlist?list=PLBB117AE85EB6BF04 

  

https://www.youtube.com/playlist?list=PLBB117AE85EB6BF04
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Connect CdC to EQASCOM 
 

Start CdC.  Click the Connect Telescope button in the toolbar: 
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Click Select in the next dialog (make sure the ASCOM tab at the top is active): 
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The ASCOM chooser pops up: 

 

 

Select ‘EQMOD ASCOM HEQ5/6’ in the drop-down (for the SkyWatcher EQ6-R Pro).  The first time you 

choose a mount, you get a prompt to configure the driver.  Click the Properties button: 

 

 

The EQASCOM setup dialog opens again.  It should already be configured.  Just click the OK button at the 

bottom as you did before to close it. 
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Click the OK button on the chooser: 

 

 

Click the Connect button on the dialog: 
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If everything goes well, CdC should connect to EQASCOM.  An EQASCOM window should open.  You 

should now see two windows like this: 

 

 

The R.A. and Dec in both windows should match.  EQASCOM should say ‘Not Tracking’ and ‘Not Parked’.  

The CdC window should show green under ‘Park’ (to match EQASCOM), and show green beside a greyed 

out ‘Connect’ button showing it is connected. 
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Click the ‘Tracking’ button in the CdC window: 

 

EQASCOM should change the track rate to Sidereal, and CdC should show green under the Tracking 

button. 

 

Minimize the EQASCOM window.  Click the ‘Hide’ button on the CdC window (or minimize it).  On the 

right side of the main CdC window, click the North button: 
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You should see something like this: 

 

 

The circles are showing where the mount is pointed. 

Zoom in using your mouse scroll wheel (or the zoom buttons on the toolbar at the top): 

 

 

 

Left click and drag to move the screen to keep the circle in view as you zoom. 
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Click on a star or other object of interest slightly to the east of the meridian: 

 

 

 

Here, I have selected NGC 188.  When an object is selected, its name will get larger, (or appear if it was 

not visible before selecting). 
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Click the ‘slew’ button in the toolbar: 

 

 

The mount should begin slewing to the target.  On your first slew, keep your mouse over the Abort Slew 

button (just in case you see a collision coming): 

 

 

Hopefully, an abort it not needed, and your mount moved to target.  CdC can now talk to your mount.  

Just having these connected is good for visual observing. 

 

Set Meridian Limits 
 

Let us set meridian limits to help prevent collisions. 

Click the South button on the right side of CdC.  Select a target a few degrees to the east of the meridian 

and perhaps 40 degrees above the horizon.  Click the Slew button to move the mount to it (being 

prepared to abort). 
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Restore the EQASCOM window. 

Click the Setup button to expand the window and UNCHECK ‘Enable Limits’ (it is checked in this 

screenshot): 
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Select Slew Rate 4 and slew WEST (hold the button down) until the indicator in CdC shows the mount 5 

degrees or so past the meridian.  Slew a bit and stop.  Do it in multiple steps.  Be careful and deliberate, 

watching your mount.  Later when you have put all your gear on, you can adjust the limits to be more 

generous if there is enough clearance. 
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Once your mount is across the meridian a few degrees, open the Mount Limits Editor by clicking the 

wrench button: 

 

 

Click the add button: 

 

 

That sets the ‘moving west across the meridian’ limit. 

Close the Mount Limits Editor window. 
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Slew EAST back across the meridian to move the mount away from the limit. 

Select a target (in CdC) well to the west (and roughly 40 degrees above the horizon) and click the Slew 

button in CdC.  Do not manually slew the scope using arrow buttons in CdC or EQASCOM.  Let CdC drive, 

and hover over the Abort button again (it should do a meridian flip).  Once done, the scope should be 

pointing toward the west with the counterweight below horizontal (on the west side).  Now, manually 

slew EAST until CdC shows the mount has crossed the meridian a few degrees. 

Open the Mount Limits Editor window and click the add button just like before.  If you look closely, you 

should see two yellow lines around the circle that are slightly below the 3 and 9 o’clock positions.  Those 

are your limits: 

 

 

Close the Mount Limits Editor window. 

Manually slew WEST to get well on the correct side of the mount. 
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RE-CHECK the enable limits checkbox: 

 

 

What I do is set these limits to something like 10 degrees, then set the meridian flip limits in my 

sequencing software to something smaller, like 5 degrees.  EQASCOM then just acts as a safety backup 

to the sequencing software. 

Click the ‘connect telescope’ button again in CdC: 

 

 

I almost always get this error dialog when I re-open the connect telescope dialog: 
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Just click OK and the scope control window pops up again.  If this bothers you, minimize that window 

instead of closing it.  I only use CdC occasionally, so I have not investigated a fix or workaround (other 

than to leave the window open and minimized). 

Click the ‘Park’ button: 

 

 

Then click ‘Yes’ on the confirmation prompt: 
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When the mount is parked, both the parking and tracking indicators will show red: 

 

 

Click the Disconnect button beside the only remaining green indicator. 

You should now see all red indicators: 

 

 

EQASCOM only opens when something is connected to it, so that window should have closed on its 

own. 
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Close the scope connection window in CdC, followed by CdC itself.  Click the Yes button to save settings 

if you like. 

Power down your mount.  Then disconnect your cables. 
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Capture Software 
 

In this section we will download and install SharpCap.  The free version is great for solar system imaging 

and includes useful tools (like focusing aids).  The paid version has an excellent polar alignment tool if 

you can see Polaris from your setup location. 

 

Download SharpCap 
 

SharpCap is available here: 

https://www.sharpcap.co.uk/sharpcap/downloads 

 

 

https://www.sharpcap.co.uk/sharpcap/downloads
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Install SharpCap 
 

Run ‘SharpCapInstall-3.2.6442.0.exe’.  Check the box to accept the license terms then click the Install 

button: 
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When the install is complete, click the Close button: 
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Camera and Filter Wheel Drivers 
 

Next we will download and install ZWO’s native and ASCOM drivers for their cameras and filter wheels. 

 

Download ZWO Drivers 
 

The ZWO drivers are available here: 

https://astronomy-imaging-camera.com/software-drivers 

 

Download the native camera drivers: 

 

  

https://astronomy-imaging-camera.com/software-drivers
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Download the ASCOM camera and EFW drivers: 
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Install Native Camera Drivers 
 

Run ‘ZWO_ASI_Camera_Driver.exe’ that was downloaded.  On the Welcome dialog, click the Next 

button: 
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Choose the install location and click the Install button: 
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If Windows gives you a security pop-up, click the Install button.  Choose whether to always trust ZWO 

driver installs or not.  I usually leave that unchecked and put up with being prompted any time I want to 

upgrade drivers. 

 

 

When the install is complete, click the Finish button: 
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Install ASCOM Camera Drivers 
 

Run ‘ZWO_ASI_Camera_ASCOM.exe’.  Choose your language and click the OK button: 

 

 

Accept the license agreement and click the Next button: 
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When ready to install, click the Install button: 
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When the install is complete, click the Finish button: 
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Install ASCOM Filter Wheel Driver 
 

Run ‘ZWO_EFW_ASCOM.exe’. 

Select your language and click the OK button: 

 

Accept the license agreement and click the Next button: 
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When ready to install, click the Install button: 
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When the install is complete, click the Finish button: 
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Camera Focus 
 

Focusing an imaging setup using stars at night can be difficult.  It is useful to try and get near focus first 

from inside your house or outside during the day.  Here are some tips to help do that. 

 

Guide Scope 
 

Attach your guide camera to your guide scope.  Then connect your camera to your computer with the 

USB cable. 

Start SharpCap. 

If Windows gives a security prompt, click the Allow Access button to allow SharpCap internet access.  

This basically allows it to check for updates and/or validate your license if you purchase the Pro version. 
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The first time SharpCap is opened, it will open an information dialog.  Click the OK button to close it. 
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Next a Tip of the Day window will open.  Check or uncheck the box depending on whether you would 

like this window to be displayed when SharpCap is opened and click the OK button: 
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Now that SharpCap is running, select your guide camera in the Cameras menu: 

 

The entries at the top in the section labelled ‘ZWO ASI Cameras’ use the ZWO native drivers.  In the 

section labelled ‘ASCOM Cameras’ you will also see entries ‘ASI Camera (1 and 2)’.  Those are the 

ASCOM drivers.  I am not sure why there are 2 entries.  I just choose the first when native drivers are not 

supported.  Choose the native driver in SharpCap since it supports it. 
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SharpCap should connect to the camera and start looping exposures.  In the bottom left area of the 

application you should see something like this: 

 

This shows a running update of frames collected, dropped, and the fps. 

With a lens cap on the guide scope, the preview area should be dark.  Take the lens cap off and it should 

brighten up, even to the point of going all-white. 
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On the right side of the application, in the Camera Controls panel, adjust the exposure time and gain on 

the right side until everything is not over-exposed.  You can use the Quick Picks drop down to select 

common exposure values, rather than typing them in.  The exposure text box understands units like ‘s’ 

for seconds, ‘ms’ for milliseconds. 
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From inside my house, I pointed my mount (with the guide-scope and camera attached) at a light fixture 

about 20 feet away.  I adjusted gain, exposure and focus until I could see the fixture. 

To adjust focus, I start either all the way in (or out), and just keep moving focus out (or in) until focus is 

reached.  One of my guide scopes focuses by moving the front lens.  Another has a helical focuser in the 

back.  Regardless of what you have, just start at one end and move toward the other a little at a time 

while watching SharpCap.  Adjust the exposure and gain so the image is not blown out but is still 

showing data in the histogram. 

This might take some time.  But it is more convenient and comfortable than doing it under the stars.  

And it does not waste clear sky time.  This is what I ended up with: 

 

In this case I ended up using an 8ms exposure time, with a gain of 50. 

This is NOT correct focus for stars but should be close enough that it (hopefully) will not take hours to 

get focused while under the stars.  To get closer to infinity focus, take your gear outside and point at a 

street sign or something with high contrast a couple hundred feet or yards away.  Some combos might 

not even focus only 20 feet away, so you might be forced to get initial focus outside.  But at least it can 

be done during the daytime. 
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Once you have achieved focus on something, select the camera in the menu again to disconnect from it: 

 

 

Close SharpCap. 
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Imaging Scope 
 

A good way to find the near focus position for your imaging scope is to find visual focus using an 

eyepiece and measure the distance from a fixed point on the back of the scope to the focal plane.  It 

might be possible with your guide scope as well, depending on what you are using.  My guide scopes are 

not meant for visual use.  If I insert a diagonal into them, it will place the eyepiece too far out to reach 

focus, which is why I used SharpCap and started at one end of the focus range and moved toward the 

other. 

To use an eyepiece (low power) to find initial spacing for your imaging scope, start by figuring out where 

the focal plane is for one of your eyepieces.  First, while looking through the eyepiece, get closer and 

closer to some printed text and see if it ever comes into focus (it probably will not): 

 

 

Assuming focus cannot be reached this way, try to find the focal plane inside the eyepiece barrel. 

Be careful doing this!  You do not want to scratch the bottom lens.  I take a pen with a cap on it, use my 

thumb as a hard-stop, insert it into the barrel and see if the end of the cap is in focus.  If not, I remove 

the cap, move my thumb down just a little, and try again.  I do this little by little until I find the distance 

(indicated by my thumb) into the barrel where the cap becomes focused.  If you wear glasses (or 

contacts) to see distance, do this while wearing them if possible. 
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Check a small distance first: 

 

Hold the pen at that distance and check focus by looking into the eyepiece while holding the cap at that 

position: 
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Slowly, carefully, check incrementally deeper into the barrel until you reach focus.  For my eyepiece, I 

reached focus just as the pen cap was near the chrome/black barrier: 

 

 

I got kind of lucky that the focal plane of my eyepiece is (or is close to) the boundary of the black barrel 

with the 1.25” chrome insert.  If your eyepiece focal plane is not at that boundary, measure how far 

below (or above) that boundary it is.  Your measurement does not need to be perfect.  It just needs to 

be close. 
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Now that you know approximately where the focal plane is for the eyepiece you are using, use that 

eyepiece to focus your main scope on something far away (the farthest thing you can find).  Once you 

have focused visually, measure the distance from a non-moving part of the scope to the eyepiece focal 

plane.  That should give you a good starting point for your scope/camera spacing: 

 

In the image above, if that were focused visually for the eyepiece, I would add distances 1 and 2 to get 

the focusing position for my camera (from the NON-MOVING part of my scope).  Get spacers that allow 

you to rack in and out around that position.  In other words, consider that part of the focus tube is 

extended in the picture above.  You also need to factor in the thickness of your filter wheel if you have 

one. 

As an example, assume 1+2 was 100mm, my focuser was racked out 20mm and it was able to be racked 

out another 20mm.  I use a ZWO EFW (filter wheel).  It is 20mm thick.  I would want to get spacers that 

(when combined with my 20mm thick EFW) placed my imaging sensor 80mm from the back of the 

MOVING focuser tube.  Then, when racked out 20mm, the sensor would be at 100mm (the focus 

position), with the ability to rack in and out 20mm. 

Look up the specifications for your imaging camera.  The sensor itself will be some distance back from 

the front of the camera body.  For the ASI1600, that distance is 6.5mm.  If we go with 1+2 = 100mm 

above, with the focuser racked out 20mm, I will need spacers that put the front of the EFW 53.5mm 

from the back of the MOVING focuser tube (80-20-6.5mm).  If I were not using an EFW, I would need 

spacers that put the front of the camera 73.5mm from the back of the MOVING focuser tube. 

The main idea is: Find the distance to the focal plane visually.  Then considering your camera’s sensor 

spacing, your filter wheel thickness and your focuser’s ability to rack in/out, choose appropriate spacers 

so that when everything is connected, your sensor will be at the focal plane with room to rack focus 

both in and out around that position. 
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Once you have figured out the spacing you need for your camera (and have obtained the spacers), install 

your imaging camera onto your imaging scope and rack focus out until your camera sensor should be 

close to focus. 

Since your imaging scope is likely to be greater than 400mm, it is a good idea to set it up on your mount 

(outside) so you can point it at a distant object with a stable support. 

Once the mount/scope/camera are set up, connect your camera and filter wheel to your computer with 

their USB cables. 

Start SharpCap. 

SharpCap needs to know about the filter wheel, since we have not used it yet. 

Under the File menu, select ‘SharpCap Settings’: 

 

 

Select the Hardware tab, then ‘ZWO FilterWheel (1)’ (the first ASCOM driver) in the Filter Wheel 

dropdown.  Then click the Properties button: 
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There appears to be native control of the filter wheel available.  Use the ASCOM one for now.  We are 

going to set up the ASCOM properties so they can be used by other applications.  Feel free to change to 

the native driver after setting up the ASCOM driver if you like.  I only use the ASCOM driver.  Since filters 

are not switched frequently, there is no performance benefit to using a native driver. 

Click the Edit button in the ASCOM dialog: 
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Edit the ‘Filter Name’ column for each of your filters, then click the OK button: 

 

 

Click the OK button in the remaining dialog: 
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Click the Apply button followed by the OK button: 
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On the right side of SharpCap, you should now see the filter wheel info under the Scope Controls panel: 

 

 

The blue shaded filter is the selected filter.  If L is not already selected, select it and the filter wheel 

should move to that filter. 

It is not needed now, but if you decide to image with SharpCap, you can control the camera cooler 

under the Thermal Controls panel: 
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Connect to the ASI1600 native driver under the Cameras menu (just like before with the guide camera). 

Now that the imaging camera is connected and looping, and the filter is set to L, proceed to dial in your 

rough focus on some distant street sign or something else with high contrast (leaves of a tree with bright 

sky shining through from behind). 

Once you get a focused image displayed in SharpCap (adjust exposure and gain as necessary), measure 

(and record) how far the focuser is racked so you can quickly return to this position when needed. 

Select the imaging camera in the Cameras menu to disconnect from it. 

Close SharpCap. 

Using an SCT 
You can install the visual back, diagonal and eyepiece, and measure the distances just like with a 

refractor.  Try to get your imaging sensor spacing close to that.  If for some reason, you cannot get your 

camera sensor close to the focal plane when using an eyepiece, it is most likely not a problem.  SCTs 

have a huge range for the focal distance.  When focusing the focal plane moves as the mirror is moved, 

rather than the eyepiece (or camera) moving.  Getting close to where an eyepiece focuses is worth 

trying, but it is not necessary. 

One approach would be to turn the focus knob all the way clockwise until the mirror is all the way back.  

Then turn the focus knob counterclockwise counting the turns.  Take note of the number of turns to get 

to visual focus.  Hook up SharpCap and see how many turns from that position it takes to reach focus 

with the camera attached.  Take note of that too.  Then you can consistently find ‘near focus’ for visual 

or imaging by using those turn counts. 

Using a focal reducer or field flattener 
Focal reducers and field flatteners usually have specific requirements on the spacing from the FF/FR to 

the camera sensor specified by the manufacturer.  Set your camera sensor/FF/FR spacing to the 

manufacturer’s requirement. 

I would then start with the FF/FR all the way in (or out), and slowly rack out (or in) with a refractor.  

With an SCT, I would start with the mirror all the way out, and slowly move it in (pushing against 

gravity). 

Since SharpCap will be updating the view quickly, you should be able to find near focus.  If you cannot 

find focus during the day using SharpCap, check if you need different spacers.  If you think the spacing is 

OK, check the exposure settings in SharpCap.  Try your best to get near focus during the day because if 

you are having trouble, doing it at night is just going to be more frustrating. 
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Guiding 
 

PHD 2 is used for guided imaging.  It analyzes images captured from a guide camera and makes small 

adjustments to the mount to keep your target framed.  It also provides dithering and other tools. 

 

Download PHD2 
 

PHD2 is available here: 

https://openphdguiding.org 

Grab the latest Windows installer: 

 

 

  

https://openphdguiding.org/


Page | 78  
 

Install PHD2 
 

Run ‘phd2-2.6.9-installer.exe’. 

On the welcome dialog, press the Next button: 
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On the setup dialog, choose your install folder and click the Next button: 

 

 

Choose the Start Menu folder and click the Next button: 
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When ready to install, click the Install button: 

 

 

Once the install is complete, uncheck ‘Launch PHD 2’ and click the Finish button: 
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Plate Solving 
 

Plate solving software analyzes images from your camera to determine the RA and Dec to a very high 

degree.  This can be used to help find your target, center your target, sync to the mount to correct for 

setup problems, etc.  We will download and install ASTAP and its star database. 

 

Download ASTAP 
 

ASTAP is available here: 

https://www.hnsky.org/astap.htm 

 

Download the application 

 

 

Windows gave me a warning.  Click ‘…’ followed by ‘Keep’. 

https://www.hnsky.org/astap.htm
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Windows complains yet again (because it does not know enough about the file).  Click ‘Show More’ 

followed by ‘Keep Anyway’. 

 

 

 

Download the star database 
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Install ASTAP 
 

Install the application 
Run ‘astap_setup.exe’. 

Windows complains again.  Click More Info: 
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Then click the Run Anyway button: 
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On the destination dialog, select the install folder and click the Next button: 

 

 

Select the Start Menu folder and click the Next button: 
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Choose whether to create a desktop icon and click the Next button: 
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When ready to install, click the Install button: 
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Read the information and click the Next button: 
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Finally, uncheck the Launch checkbox then click the Finish button: 
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Install the star database 
Run ‘g17_star_database_mag17_astap.exe’. 

On the destination dialog, choose the install folder and click the Next button: 
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When ready to install, click the Install button: 
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Finally, click the Finish button: 
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Sequencer 
 

Sequencer applications are used to execute imaging plans.  You enter target information, camera gain, 

exposure time and number of images to take (per filter).  Most allow multiple targets, multiple hardware 

profiles, etc.  They then connect (through ASCOM usually) to your mount, your camera, filter wheel, 

plate solving software and PHD 2, and ‘direct traffic’ to them all to collect your data. 

NINA is a free and open source sequencer project under active development that is relatively easy to set 

up and use.  We will download, install and set up NINA since it is designed for simplicity and is also free.  

For more complex features, or to do unattended imaging, consider Sequence Generator Pro, Voyager or 

other choices.  NINA is perfect to start with however. 

 

Download NINA 
 

NINA is available here: 

https://nighttime-imaging.eu/download/ 

 

 

 

  

https://nighttime-imaging.eu/download/
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Install NINA 
 

Unzip ‘NINASetupBundle_1.10.1.9001.zip’. 

Right-click the file and select ‘extract all’: 
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Leave the defaults and click Extract: 
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Run the extracted file: ‘NINASetupBundle.exe’. 

If Windows complains, click More Info followed by Run Anyway just like with ASTAP. 
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Accept the terms (check the box), then click the Install button: 
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When the install is complete, click the Close button: 
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Setup PHD2 
 

Connect your guiding camera and mount (through the adapter if required) to your computer, and power 

up the mount. 

Launch PHD2. 

A first light wizard starts.  Click the Next button: 
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On the next dialog, click the Guide Camera drop-down and select ‘ZWO ASI Camera’ at the bottom: 
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Click the Yes button since the camera is already connected: 
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PHD2 should recognize the pixel size automatically and grey-out the entry box.  Enter the focal length of 

your guide scope and click the Next button: 
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On the next dialog, click the Mount drop-down and select ‘EQMOD ASCOM HEQ5/6’: 
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Click the Yes button since the mount is already connected: 

 

 

 

The Guide Speed value changed from 0.5 to 0.2 because EQASCOM needs to be updated. 

Click the Next button: 

 

 

Click the link to open the EQMOD document, then click the Proceed button: 
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On the next dialog, leave ‘None’ selected for AO then click the Next button: 
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Enter a Profile Name, uncheck ‘Build dark library’ (unless you want to build one now), then click the 

Finish button: 

 

 

Now connect your imaging camera and filter wheel (if you have one) to the computer. 

In the lower left of the application window, click the ‘Connect to Equipment’ button (it looks like a USB 

connector): 
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On the Connect Equipment dialog, click the Camera Chooser button (the button with two arrows): 

 

 

Select your guide camera if the black dot is not on it.  Here, PHD 2 would have defaulted to connecting 

to my imaging camera: 

 

We connected only the guide camera during initial setup so PHD 2 would pull the pixel size from it.  We 

then connected the imaging camera so PHD 2 would see both during this step and we could tell it which 

one to use when both are connected. 
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Now when I click the chooser button, I see the black dot on my guide camera: 

 

 

Click the Configure button for the mount (it has a picture of a wrench and a screwdriver): 
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The EQASCOM Setup dialog opens.  Verify the settings mentioned in the doc are correct then click the 

OK button: 
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Back on the PHD 2 Connect Equipment dialog, click the Connect All button: 
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PHD 2 will connect to the guiding camera and the EQASCOM driver, causing its window to open.  The 

EQASCOM window should be flashing ‘PARKED’.  Click the Setup button on the EQASCOM window (it has 

a picture of a wrench): 
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The EQASCOM window will expand.  Check the other settings mentioned in the doc.  My pulse guide 

settings were set to 0.10x (the defaults).  Increase them to at least 0.5x up to 0.9x. 

 

 

Click the Setup button again to collapse the window. 

Minimize the EQASCOM window. 

 

Click the Begin Looping button in PHD 2 (beside the Connect button): 
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PHD 2 will start downloading images from your guide camera in a continuous loop.  You should see dark 

frames with the lens cap on, white frames with it off.  You just want to see if PHD 2 appears to be talking 

to the camera successfully.  Click the Stop button: 

 

 

Click the Connect Equipment button again: 

 

 

On the Connect Equipment dialog, click the Disconnect All button: 
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Once the Disconnect All button greys out, click the Close button: 

 

 

The EQASCOM window should have closed on its own since PHD 2 was the only thing connected to it. 
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Under the Tools menu, verify ‘Enable Server’ is selected.  This allows other applications to communicate 

with and control PHD 2. 

 

 

Close PHD 2. 

 

If you decide to take a break, power down the mount and disconnect the USB cables.  Otherwise, just 

leave it all connected and powered up and continue with setting up NINA. 
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Setup NINA 
 

If necessary, connect both cameras, filter wheel and mount to your computer and power up the mount. 

Launch NINA. 

If you get a firewall warning, click the Allow Access button: 

 

 

 

 

In NINA, the Equipment/Camera icons (in the upper left) should already be highlighted.  If not, click the 

Equipment icon followed by the Camera icon. 
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In the Camera drop-down, select the Native ASI driver for the imaging camera (the one listed under the 

ZWO heading): 

 

 

Then click the Connect button: 
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You should see the page update once NINA connects to the camera: 

 

 

It should retrieve the pixel size and other parameters from the camera driver.  You can change the 

default gain, offset, cooling temp, etc. now if you want to. 
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Select the Filter Wheel icon: 

 

 

Select ‘ZWO FilterWheel (1)’ from the ASCOM section of the drop-down: 
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Then click the Connect button: 

 

 

You should see the page update once NINA connects to the filter wheel. 

On the left, the currently selected filter will be displayed (L in this screenshot).  And on the right will be 

the list of filters available (the ones set up earlier through SharpCap): 
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Select the Telescope (mount) icon next: 

 

 

 

Select ‘EQMOD ASCOM HEQ5/6’ from the ASCOM section of the drop-down.  Then click the Connect 

button: 
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When NINA connects to the EQASCOM driver, the EQASCOM window should open and be flashing 

‘PARKED’. 

Minimize the EQASCOM window. 

NINA warns the latitude/longitude of the mount and NINA do not agree.  Since we have set up 

latitude/longitude in EQASCOM already, sync from mount to NINA (click the Telescope to NINA button): 

 

 

 

Click the Guider icon: 
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If PHD 2 is not selected already, select it in the drop-down.  Click the Connect button: 

 

 

NINA should launch PHD 2, instruct it to connect to your guide camera, and start looping exposures. 

 

Now Click the Options icon in the left-most column: 
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Click the Plate Solving tab at the top of the application: 

 

 

Select ‘ASTAP’ in the Plate Solver drop-down, and ‘Astrometry.net’ (or ASTAP) in the Blind Solver drop-

down.  Select the ‘L’ filter in the Filter drop-down.  This tells NINA you want to plate solve using the L 

filter, even if you are capturing data using a different filter.  You can also set it to ‘Current’ to use 

whatever is being used for capture, or any other filter you want.  Set gain to 139 (unity on the 1600), or 

some other value you want. 

 

 

If you have trouble with plate solves, go to this options page and adjust the exposure time, gain, filter 

etc. 
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Select the Imaging tab: 

 

 

The top part of this page has several options you should examine and set.  Choose the file type you want 

your images saved as (TIFF, FITS, XISF) and the folder they should be saved in. 

Enable ‘Auto Meridian Flip’. 

Set ‘Minutes After Meridian’ to a value LOWER than the meridian limits you set in EQASCOM earlier.  5 

minutes should be fine if you set the EQASCOM limits to several degrees on each side of the meridian. 

Set ‘Use Telescope Side of Pier’ to ON if your mount driver supports it.  I believe EQASCOM on the EQ6-R 

Pro does. 

Set ‘Recenter After Flip’ to ON.  This will plate solve and move the mount to recenter the target after a 

meridian flip (especially useful if your mount has cone error). 

 

Here are my settings after making these changes: 
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Select the ‘Equipment’ TAB at the top.  This is with the ‘Options’ icon on the left still selected.  Do not 

click the ‘Equipment’ icon on the left. 

 

 

 

In the Telescope section, name your scope and enter its focal length and ratio: 

 

 

In the Planetarium section (lower right, you may need to scroll down to see it), select CdC in the drop-

down: 
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Select the Equipment icon again (in the left column).  Notice all the small power indicators next to the 

equipment that has been connected: 
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In turn, click on each of them (Camera, Filterwheel, Telescope and Guider), and click the Disconnect 

button at the top of the page to disconnect each: 

 

 

Click the OK button for each device that prompts for confirmation: 

 

 

Close NINA. 

 

PHD 2 is still running, and still connected to EQASCOM.  In PHD 2, click the Stop icon, followed by the 

Connect icon, then ‘Disconnect All’ like previously.  Close the Connect dialog.  Then close PHD 2. 
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Make sure all the software is closed. 

 

Launch NINA again. 

Click the ‘Connect’ button at the lower left corner of NINA: 

 

 

Then click the OK button on the Reconnect All Devices prompt: 

 

 

NINA should connect to the mount, camera, filter wheel, and launch and connect to PHD 2.  PHD 2 

should have connected to the guide camera and started looping.  And EQASCOM should have been 

launched in PARKED mode. 

This was to verify everything could be started and connected from NINA. 
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Verify Image Capture 
 

Minimize the EQASCOM window and bring NINA to the foreground. 

Click the Imaging icon in the left column: 

 

 

At the top of the application, click the icons of panels you do not need to turn them off (like focuser, 

weather, flat panel, etc.).  Click them on/off to see the panels appear/disappear.  Some panels may be 

combined with others, and you may only see a tab appear/disappear.  I have noticed a panel that is 

turned off may reappear in a different location when turned back on.  So, you may have to look closely 

to see what exactly is changing. 

 

 

Once you have the desired panels activated, you can then move them around on this page to create an 

arrangement that suits you. 
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Arrange the ‘Image’ and ‘Imaging’ panels so they can be displayed at the same time.  If they are stacked 

with each other, you can separate them by a left-click-hold-and-drag of the panel’s tab.  i.e. ‘grab’ the 

tab and drag it out. 
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Panels that are stacked show tabs at the bottom of the stack like this: 

 

To move a panel, click-drag its header (the top part of the panel). 

 

In the Imaging panel, set an exposure, filter, binning and gain.  Leave Loop, Save, and Enable 

SubSampling OFF.  Then click the ‘Starts Exposure’ button (it has an icon of a camera lens iris): 

 

 

 



Page | 134  
 

NINA will capture an image from the imaging camera according to the settings made in the Imaging 

panel.  Once the data is captured, the Image panel should refresh and display the captured frame: 

 

 

I had the lens cap on, so NINA just showed dark, noisy data. 

 

Verify Sequencing 
 

Open CdC. 

Select (so its name is displayed) a target just a little to the east of the meridian. 

Leave it selected and switch to NINA. 
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Select the Sequence icon in the left column: 

 

 

In the upper right area of the application, click the Location icon to pull the coordinates from CdC: 
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In the Sequence area, set Start Guiding to OFF, Center Target to OFF, and Slew to Target to ON.  Set up a 

‘LIGHT’ frame sequence of say 30 1-min exposures.  Leave Dither OFF.  Since we are inside, we cannot 

guide, dither or use plate solving. 

 

 

Click the Options icon in the left column: 

 

 

Then click the Imaging tab at the top: 
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Verify Auto Merdian Flip is enabled.  Turn OFF Recenter After Flip: 

 

 

 

On the left, click the Equipment icon, then the Guider icon, and Disconnect from PHD 2.   

 

Just in case the original target drifted west of the meridian while we were setting everything up, check 

CdC to see if your selected target is still east of the meridian.  If not, choose another target that is east of 

the merdian (and select it).  Then go back to NINA, click the Sequence icon in the left column, and 

import the coordinates from CdC again.   

 

When ready, click the big ‘Play’ button in the lower right: 
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If you see this warning, just click the OK button (we do not need cooling right now): 

 

 

NINA should slew to the target and start taking images.  Once the slew is done, click the Imaging icon in 

the left column: 

 

 

At the bottom you should see the progress updating in real-time: 
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The Sequence panel also shows progress, with buttons to pause or stop the sequence: 
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The Telescope panel shows when a meridian flip should happen: 

 

 

That is what we are watching for. 

 

When the time for a meridian flip gets close, a window showing a countdown should pop up: 

 

 

After the countdown, NINA should perform a meridian flip.  After the flip, it should show progress letting 

the mount settle.  Since we disconnected PHD 2, the guiding steps are skipped (dark blue, no 

checkmarks): 
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Once done with the meridian flip and mount settle time, NINA should start capturing data again. 

 

In the Sequence panel, click the Stop icon to end the sequence. 

 

Look in the folder you specified for your data files and verify some image files were created. 

 

Click the Equipment icon, then the Guider icon, and reconnect to PHD 2. 

Click the Options icon, then the Imaging tab, and RE-ENABLE ‘Recenter After Flip’. 

Click the Sequence icon, then turn ‘Start Guiding’ and ‘Center Target’ back ON. 

Click the Equipment icon, then the Telescope icon.  Click the ‘Park’ button in the lower right: 

 

 

 

Now click through the connected items and disconnect them all like before. 

Close NINA. 

Click the OK button to close without saving the sequence.  It was just a test to capture data and verify a 

meridian flip. 
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In PHD 2, stop looping, disconnect all equipment, and close PHD 2. 

Close CdC. 
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Under the Stars 
 

We have done a lot to get an imaging setup prepared.  We have installed multiple applications and 

drivers.  We have configured them so they will communicate with each other.  We have nearly focused 

our scopes.  And we have even executed a short test sequence to verify image capture and a meridian 

flip.  But the final pieces need to be done in the dark, under the stars. 

We still need to polar align our mount, get final focus on our cameras, calibrate PHD 2, and get some 

actual data. 

 

Polar Alignment 
 

Your mount needs to be polar aligned.  Depending on the method you use, this could be done before 

you even attach your scope.  Since there are many ways to polar align a mount, I am only going to briefly 

mention a few of them, without going through their steps. 

Polar scope 
For someone first starting out, if you can see Polaris from where you set up and your mount has a polar 

scope (the EQ6-R Pro does), I highly recommend using it.  You can get polar aligned very quickly and 

more than accurately enough just by using the polar scope.  But you need to know how to do it.  This pdf 

has a good description of that process: 

http://eq-mod.sourceforge.net/docs/PolarScopeAlignment.pdf 

A couple of notes on the EQ6-R: 

• The mount needs to be powered on to illuminate the polar scope. 

• The counter-weight bar MUST be lowered.  When raised into the mount head for storage/travel, 

the bar itself blocks the polar scope. 

• The Dec axis also needs to be rotated to allow the scope to see through the bar inside.  Once 

you remove the front cap, you can see the hole in the bar as you rotate the Dec axis. 

The pdf above describes using the EQMOD software to help you align the mount.  If you do not quite 

understand why the various steps are taken, then you should probably connect your laptop and follow 

them very carefully. 

If you read through the pdf and it clicks what is being done (and why), then you will not need to connect 

the laptop and go through all the steps.  You will need to understand how to align the polar scope 

properly (where to rotate your RA axis before starting), then use an app to tell you where Polaris should 

be placed on the hour angle circle. 

I have 2 problems with using the polar scope.  1) Polaris is not visible from where I image.  2) The polar 

scope is a straight-through design and looking up through it from 2-3 feet off the ground is not 

comfortable for me. 

http://eq-mod.sourceforge.net/docs/PolarScopeAlignment.pdf
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PHD 2 
PHD 2 has some polar alignment tools. One of them is a drift align tool.  If you cannot see Polaris from 

where you set up, you can use the PHD 2 drift align tool. 

SharpCap 
If you can see Polaris from where you set up, and you do not mind spending approximately $15 a year 

for a SharpCap Pro license, this is probably the most-recommended method of polar alignment.  It is 

easy, fast, and accurate. 

NINA 
NINA has an alignment routine that does a drift align without waiting on an actual drift.  Instead, it does 

a plate solve, slews the mount a little, then does another plate solve.  It then tells you how far E/W or 

N/S your mount’s R.A. axis is pointed, depending on whether you are ‘drifting’ near the meridian or near 

the horizon.  I have started using this tool and like it.  I used to do a drift align in PHD 2, but this method 

is faster because of the plate solve/slew time vs. drift time. 

Final thoughts 
There may be other tools available as well that I am not aware of.  Also, if none of this makes sense, just 

point your RA axis as close to Polaris as you can eyeball it.  Finish getting your gear all working and make 

sure you can get some real data.  Then ask for help from the club.  Someone will be able to help you 

learn how to polar align. 

 

Final Focus 
 

Now that the mount is polar aligned, we can finish getting the imaging and guiding scopes focused on 

infinity.  Attach your equipment to the mount if needed (and balance it).  Put the mount in the ‘Home’ 

position.  Make sure the clutches are engaged.  Connect all the USB cables to your computer and power 

everything up. 

Launch CdC. 

Open the connect telescope dialog: 
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Click the Connect button: 

 

Once connected, click the Unpark button.  Once unparked, click the Tracking button. 

Minimize the Connect dialog and the EQASCOM window. 

Using CdC, find a bright star high in the sky, select the star, then click the Slew button: 

 

 

The mount should slew to the star. 
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Open SharpCap. 

Under the Cameras menu, select your guiding camera: 

 

 

  



Page | 147  
 

Under Camera Controls on the right, adjust the exposure and try to find one or more out of focus stars. 

I initially focused at about 20 feet inside my house.  This is what I saw with an 8s exposure when pointed 

at the sky: 

 

 

If you do not see anything, use the EQASCOM window’s NSEW controls to move the scope a little at a 

time.  Speed 1 will probably be too slow.  3 was good for my setup. 

Once you find a star and SharpCap is looping on it, start adjusting focus on your guide scope. 
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As I started getting closer to infinity focus, the bright star started clipping (getting blown out to all-

white): 

 

So, as you get closer to focus, you will most likely need to reduce the exposure time. 
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After more focus adjustments (and exposure reduction), the star image started getting smaller: 

 

 

Now we can use a SharpCap tool to get close as possible.  If you have a Bahtinov (or other type) focusing 

mask, you can use it instead of the SharpCap tool. 
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Under the Tools menu, in the Focus Assistant sub-menu, select FWHM Measurement: 

 

 

FWHM stands for Full Width Half Max and is a way of measuring the intensity profile of a star’s image.  

The more focused a star, the lower this number will be.  A red square will appear in the image area.  Left 

click and drag it to place it over the star you are focusing on.  The corners can also be dragged to make 

the square smaller.  Adjust the size so it only encloses the one star. 
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SharpCap will measure the FWHM of the star with each loop and display a running update of the 

measurements.  As you adjust focus on the guiding scope, the measurements will either trend up or 

down.  Watch the Now/Best FWHM measurements on the right in addition to the trend plot.  When 

moving focus, you may see temporary jumps in the measurement up or down.  Let the measurements 

settle before deciding which way to move next (or whether to stop focusing).  Once you have minimized 

the FWHM to your satisfaction, lock focus if it can be. 

 

 

Select Tools->Focus Assistant->FWHM Measurement again to close the tool. 

 

Now do the same for the imaging camera. 

Under the Cameras menu, select the guide camera to disconnect it.  Then under the same menu, select 

the imaging camera to connect to it. 

On the right side of the application, find the filter wheel and select the L filter. 

Set a high exposure time and gain. 

Once you have an exposure/gain where you can see some out of focus stars, go through the same 

procedure to dial in focus for the imaging camera. 

Once focus is done, lock down the focus if you can and close the focusing tool. 

Select the Camera to disconnect it. 

Close SharpCap. 

Note: If you cannot find any stars because you are too far out of focus or cannot seem to choose an 

exposure time and gain to display them, aim the mount at the moon.  If you can find the moon, you 

should have no problems choosing a gain and exposure time that will show it.  Turn them down so the 

image is not blown out and focus on the moon.  Once the moon is in focus, aim the mount at a star 

again.  Turn the gain up if needed to make the star visible.  Then use the focus tool to dial in final focus. 
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Calibrate PHD 2 
 

Now we need to calibrate PHD 2.  PHD 2 will move the scope in R.A. and Dec to figure out how your 

guiding camera is rotated with respect to the sky.  It uses this information when guiding to know which 

axis to move (and the direction) based on how the star moves in the guide camera.  The rotation does 

not really matter, but I try to orient mine so the sensor is ‘up/down/left/right’ along with the mount 

anyway. 

This calibration will need to be done every time the orientation of the guide camera’s sensor changes.  

So, if you use an eyepiece holder to hold the camera, and you remove it after you are done for the night, 

it is almost certain to have a different orientation the next time you set up.  It is a good idea to leave 

your cameras attached to your scopes if possible. 

In CdC, select a star somewhere near the meridian and the celestial equator.  Slew to it. 

Start PHD 2. 

Connect (to both the mount and the guiding camera) and start looping. 

 

 

 Select a looping speed for PHD 2 (I use 3s): 
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In PHD 2, under the Tools menu, select Auto-Select Star.  PHD 2 will choose a star that it considers 

‘good’ to guide on. 
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PHD 2 places a green square around the star it chooses.  While holding down Shift, click on the Guiding 

button to force a calibration: 

 

 

If you get a prompt for creating a dark library and/or a bad-pixel map, close it.  You can do those later if 

desired. 
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PHD 2 will start nudging the scope in R.A. and Dec, measuring the movement of the selected star.  Let 

the calibration run to completion. 

 

 

Once the calibration is complete, click the Auto-Restore button to automatically restore this calibration 

when you use this hardware profile.  If you think you will need to calibrate every session (you remove 

the guide camera from the guide scope each night), just click the Close button. 
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Select View->Display Graph (if it is not already displayed): 

 

 

You will now see the guiding graph at the bottom of the application, showing the R.A. and Dec 

adjustments being made. 

 

 

Using the View menu, display any other panels you want to see. 
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Guiding Assistant 
 

PHD 2 has a guiding assistant that will help choose guiding settings for your mount/camera combo that 

will help prevent ‘chasing seeing’.  This is optional, but a good idea to do. 

If you want to run the guiding assistant, under the Tools menu, select Guiding Assistant.  You need to be 

guiding when you do this, even though the assistant is going to turn guiding off.  If you continued 

directly from the section above, then guiding is already on.  If guiding is not currently on, select a star, 

then click the Guiding button WITHOUT holding down the Shift key. 

 

Click OK at the prompt: 
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Do as PHD 2 says, letting the assistant run until the polar alignment error and RMS values stabilize.  It 

says to let it run for 2 minutes minimum.  You may need to let it run longer depending on your 

equipment. 

 

 

Once the measurements have stabilized, click the Stop button. 
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PHD 2 will then show some recommendations based on the measurement it collected during the run.  If 

you want to use the settings PHD 2 recommends, click the Apply buttons: 

 

If you look at the backlash section below the Apply buttons, you can see my mount has significant Dec 

backlash.  PHD 2 can be told to only correct Dec in one direction (or even not at all).  But what to choose 

depends on where in the sky you are going to be imaging.  If you think you might need to adjust for Dec 

backlash, the PHD 2 site talks about it: https://openphdguiding.org/man-

dev/Advanced_settings.htm#Declination_backlash_comp 

 

Close the Guiding Assistant window. 

Stop guiding (the Stop Sign button). 

Click the Connect button, then Disconnect All on the Equipment dialog. 

Close the dialog, then close PHD 2. 

 

Restore the CdC scope window and click the Park button to park the scope. 

Once the mount is parked in the Home position, click the Disconnect button and close the scope 

window. 

https://openphdguiding.org/man-dev/Advanced_settings.htm#Declination_backlash_comp
https://openphdguiding.org/man-dev/Advanced_settings.htm#Declination_backlash_comp
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Leave CdC open. 

 

 

Run a Sequence 
 

Everything should be in place now to run a sequence. 

Start NINA. 

Use the Connect button in the lower left of NINA to connect to all equipment. 

 

In CdC select a target.  Here, I put M31 in the search box at the top of CdC and hit the Enter key.  You 

can also drag the sky around to find something visually then click on it. 

 

 

Your selected target should have its name displayed in the sky view area of the application. 
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In NINA, click the Sequence icon on the left: 

 

 

Then import coordinates from CdC.  Click the ‘location’ button in the upper right: 
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NINA will pull the coordinates from CdC, and update the page with info about it, showing the rise/set 

times, the name, etc.: 

 

  



Page | 163  
 

Now that the target info is imported, set up the rest of the sequence.  Set Start Guiding, Slew to Target 

and Center Target all to ON.  This will tell NINA to slew to the target when the sequence starts, use Plate 

Solving to center it, and turn on guiding before capturing data. 

Also, on this page, set the number of frames to capture, the exposure time, the type of frame (LIGHT), 

the filter to use (L), the binning, whether to dither, the gain and offset. 
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After making all my selections, the page now looks like this: 

 

I have set a simple sequence of 5 L frames of 30 seconds each using a gain of 139 (unity for the ASI1600) 

and an offset of 50.  I left dithering OFF because this was just a short sequence to use as an example. 
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Click the Imaging icon on the left of the application. 

In the Cooling panel, set your target temperature, and start cooling.  If the panel is not visible, use the 

buttons at the top of the page to display it.  If it is in a stack, click its tab to bring it to the front.  And you 

may need to click the little triangle to expand the cooler controls. 

Once the cooler reaches the target temperature, click the ‘Play’ button in the Sequence panel: 

 

 

A dialog will pop up saying the mount will be unparked.  Click the OK button: 
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NINA will now proceed to slew to the target, use plate solving to center it, direct PHD 2 to choose a star 

and start guiding, and start collection data.  The Sequence panel (and the status bar at the bottom) will 

show progress as the sequence runs (I changed the number of subs to 10 before starting to make sure I 

had time to take some screenshots).  The Image panel will show the latest image captured: 

 

 

This was a short sequence for demo purposes.  Once you are set up and capturing data, do not stop 

here.  Repeat the above steps and make more sequences to capture more data for the targets that 

interest you. 

  



Page | 167  
 

Once you are done for the night and all your sequences are complete, warm the cooler.  Click the 

Equipment icon, then the Camera icon, then the ‘Fire’ button.  These controls are also on the Camera 

panel when we had Imaging selected during the sequence run.  I just want to highlight a lot of the 

settings in NINA are repeated in different locations. 
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While the cooler is warming up, select Equipment, then Guider, then Disconnect to disconnect NINA 

from PHD 2: 

 

 

 

Switch over to PHD 2, stop guiding, disconnect from all equipment and close PHD 2: 
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In NINA, select the Equipment icon, then the Telescope icon, and Park the mount: 

 

 

Once the camera has warmed up (above 0 degrees at least), proceed to disconnect NINA from the 

camera and filter wheel. 

Close NINA. 

Close CdC. 

Turn off your mount. 

Shut down your computer. 

Disconnect all the cables and pack up your gear. 

Enjoy learning how to process data. 

Good luck! 
 

 


